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Bienvenido a tu curso 

AutoCAD Plant 3D 

  

Gracias por tu confianza al inscribirte en este curso. Al término de este estarás 

preparado para producir diagramas de tuberías e instrumentación (P&ID), los 

cuales serán integrados en un modelo de diseño de planta en 3D. Los instructores 

brindan capacitación práctica para la creación de diagramas esquemáticos y 

diseños de planta utilizando herramientas especializadas de AutoCAD Plant 3D. 

En la guía encontrarás descripciones, consideraciones y recomendaciones clave 

centradas en la implementación del proceso que ayudarán a cumplir las 

necesidades de tus proyectos de diseño.  

 

Al finalizar el curso, podrás generar diagramas P&ID, trabajar con modelos 3D y 

generar informes isométricos y ortográficos. -￼ 

 

Preguntas frecuentes sobre nuestros Cursos Presenciales  

 

Preguntas frecuentes sobre nuestros Cursos Online 

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
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Derechos reservados 

© Todos los derechos reservados Darco© 

 
Todos los materiales contenidos en este sitio (incluyendo, pero no limitado a, texto, 
logotipos, contenido, imágenes [animadas y estáticas], iconos, videos y fotografías, entre 
otros) están protegidos por las leyes de Derechos de Autor y Propiedad Industrial, tanto 
nacionales como internacionales. 
 
En relación con todo lo contenido en esta guía de estudio, se prohíbe la reproducción, 
uso, copia, impresión, distribución, publicación, traducción, adaptación, reordenación y 
cualquier otro uso o modificación total o parcial de los datos y obras contenidos en esta 
página, por cualquier medio y, de cualquier forma. 
 
Para cualquier asunto relacionado con este aviso, por favor contacte a 
darco@darco.com.mx 
 
Aviso de Privacidad 
 
La privacidad de sus datos personales es de gran importancia para Darco por lo que 
hacemos de su conocimiento nuestro Aviso de Privacidad en 
www.darco.com.mx/privacidad 

 
Darco© es una marca registrada 

Autodesk© es una marca registrada￼  
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Capítulo 1 
 

Introducción 
 
Interfaz de usuario: Pantalla de Inicio  
 

 
 

1. Pestaña de Inicio  
2. Abrir o Iniciar un Proyecto   
3. Lista de Documentos Recientes  
4. Notificaciones  
5. Conexión  

 
Pestaña de Inicio (1) 
 
La pestaña de inicio indica que el software ha sido ejecutado de manera exitosa. Permite 
iniciar un nuevo proyecto o abrir un proyecto existente.  

 

 
 
Regresar a la Interfaz 
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Abrir o Iniciar un Proyecto (2) 
 
Permite abrir un proyecto existente o iniciar un nuevo proyecto.  
 

 
 

Regresar a la Interfaz 
 

Lista de Documentos Recientes (3) 
 
Muestra un listado con los dibujos recientes que se han trabajado con AutoCAD Plant 3D, 
permitiendo acceder a ellos de manera rápida y sencilla.  
 

 
 

Regresar a la Interfaz 
 

Notificaciones (4) 
 
Muestra avisos sobre actualizaciones del producto e información relacionada con el 
mismo.  
 

 
 

Regresar a la Interfaz 
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Conexión (5) 
 
Permite iniciar sesión para acceder a los servicios en línea, así como enviar 
retroalimentación del producto al fabricante.  
 

 
 

Regresar a la Interfaz 
 
Interfaz de usuario: Pantalla de Trabajo  
 

 
 

1. Menú de Aplicaciones 
2. Barra de Herramientas de Acceso Rápido 
3. Barra de Título, Ayuda y Perfil 
4. Barra de Herramientas  
5. Pestaña de Dibujos  
6. Área de Dibujo 
7. Cubo de Vistas  
8. Línea de Comandos 
9. Barra de Estado 
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Menú de Aplicaciones (1) 
 
Permite acceder a las principales herramientas del software: Nuevo, Abrir, Guardar, 
Importar, Exportar, Publicar, Imprimir.  

 

 
 

Regresar a la Interfaz 
 
Barra de Herramientas de Acceso Rápido (2) 
 
Permite acceder a acciones habituales de archivo como Nuevo, Abrir, Guardar, Deshacer, 
Rehacer. El software permite la personalización de esta barra.  
 

 
 
Regresar a la Interfaz 
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Barra de Título, Ayuda y Perfil (3) 
 
Muestra el nombre del archivo activo; es decir, el archivo sobre el cual se está trabajando. 
Además, proporciona un conjunto de herramientas que permiten acceder a fuentes de 
información relacionadas con el producto y el perfil de usuario.   
 

 
 
Regresar a la Interfaz 
 
Barra de Herramientas (4) 
 
Permite el acceso a las diferentes herramientas de AutoCAD Plant 3D. La barra de 
herramientas se divide en pestañas y paletas para organizar las herramientas en 
agrupaciones lógicas.  
 

 
 
Regresar a la Interfaz 
 
Pestaña de Dibujos (5) 
 
Muestra los dibujos abiertos, y permite navegar entre ellos sin necesidad de cerrarlos. Es 
importante tomar en cuenta que, cuantos más dibujos se encuentren abiertos, más 
recursos requerirá el software para poder trabajar.  
 

 
 

Regresar a la Interfaz 
 
 
 
 
 
 
 
 
 
 
 



11 
 

Área de Dibujo (6) 
 
Es la zona central de la pantalla, y está destinada para la realización de los diseños.  
 

 
 
Regresar a la Interfaz 
 
Cubo de Vistas (7) 
 
Es la herramienta de navegación en 2D y 3D que permite cambiar fácilmente vistas 
ortogonales e isométricas con un simple clic o arrastre. Además, permite modificar de 
manera rápida el sistema de coordenadas actual  
 

 
 

Regresar a la Interfaz 
 

Línea de Comandos (8) 
 
Permite un flujo de comunicación ente AutoCAD Plant 3D y el usuario. Muestra 
información sobre los comandos en ejecución y solicita acciones por parte del usuario 
para completar los trabajos.  
 

 
 
Regresar a la Interfaz 
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Barra de Estado (9) 
 
Contiene herramientas de anotación, escalas de anotación, espacios de trabajo, 
unidades, propiedades rápidas y personalización.  
 

 
 
Regresar a la Interfaz 
 
Manejo de menús de cintas, paletas, menús contextuales, etc 
 
Espacios de Trabajo 
 
El comando del espacio de trabajo permite configurar y personalizar conjuntos de 
comandos para que organicen la interfaz conforme a las necesidades del dibujo. AutoCAD 
Plant 3D cuenta con las siguientes áreas de trabajo:  
 

• 3D Piping 

• PID PIP  

• PID ISO 

• PID ISA 

• PID DIN 

• PID JIS-ISO 
 
La principal diferencia entre los diversos espacios de trabajo P&ID son las paletas de 
símbolos, ya que estas mostrarán los correspondientes conforme al estándar 
seleccionado.  
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Barra de Herramientas  
 
El principal método de interacción entre el usuario y AutoCAD Plant 3D es la barra de 
herramientas. Para facilitar la creación y edición del diseño, los comandos para crear y 
editar se organizan en paneles que se agrupan por tarea. La mayoría de estos paneles de 
tareas específicas se encuentran en la pestaña Home. Los paneles que se muestran en la 
pestaña Home varían según el espacio de trabajo activo.  
 

 
 

Pestañas Isos y Structure  
 
Cuando el espacio de trabajo 3D Piping se encuentra activo, el software activará las 
pestañas Isos y Structure. La pestaña Isos contiene un comando relacionado con la 
generación isométrica. La pestaña Structure contiene comandos relacionados con la 
generación de piezas estructurales en el espacio de modelo 3D.  
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Paletas de Herramientas  
 
En AutoCAD Plant 3D, las paletas de herramientas contienen elementos específicos 
dependiendo del espacio de trabajo seleccionado. Las diferencias entre los diferentes 
espacios de trabajo P&ID son principalmente los símbolos mostrados en la paleta.  
 

• Paleta de Herramientas P&ID: Se encuentra divida en seis pestañas: Lines, 
Equipment, Valves, Fittings, Instruments y Non-engineering. Los símbolos de cada 
pestaña están agrupados para ser similares en diseño a las definiciones de clase 
en la configuración del proyecto. Se pueden agregar símbolos personalizados 
adicionales. Además, en un proyecto multiusuario, se puede crear un conjunto de 
paletas de herramientas comunes. 
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• Paleta de Herramientas 3D: Se encuentra divida en tres pestañas: Dynamic Pipe 
Spec, Pipe Support Spec e Instrumentation Spec. Cada pestaña contiene una 
selección de elementos para la especificación activa.  

 

 
 

Para navegar entre las paletas: 
 

▪ Clic derecho en la barra de título de la paleta activa → Seleccionar la paleta de 
herramientas deseada.  

 
Nota: Si bien se puede cambiar a una paleta diferente en cualquier momento, 
normalmente esta operación se debe realizar al cambiar de un espacio de trabajo P&ID a 
un modelo 3D. 
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Paleta de Propiedades  
 
La paleta de propiedades permite visualizar y modificar las propiedades de los elementos 
seleccionados en el dibujo.  
 
El software permite acceder a la paleta de propiedades a través de cualquiera de las 
siguientes formas:  
 

1. Doble clic derecho sobre un elemento del dibujo.  
2. Clic derecho sobre un elemento del dibujo → Herramienta Properties.  
3. Ingresar el comando PROPERTIES en la línea de comandos.  
4. Presionar la tecla <Ctrl>+1.  
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Menú de Acceso Directo 
 
Este menú contiene los elementos estándar de AutoCAD, así como elementos de menú 
adicionales de AutoCAD Plant 3D asociados al objeto seleccionado. Varían según el tipo 
de dibujo y el elemento seleccionado.  

 
Para acceder al menú de acceso directo: 
 

▪ Clic derecho sobre un elemento del dibujo → Seleccionar el menú deseado.  
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Administrador de Proyectos  
 
Proporciona acceso a la configuración y los datos de todo el proyecto, así como a los 
componentes de datos individuales del proyecto. Por defecto, el Administrador de 
Proyectos se encuentra a la izquierda de la pantalla. 
 
Para activar o acceder al administrador de proyectos: 
 

1. Clic en la Pestaña Home → Panel Project → Herramienta Project Manager .  
 

 
 

• Current Project (Proyecto Actual): En la parte superior de la paleta del 
administrador de proyectos se encuentra la lista del proyecto actual, que muestra 
el proyecto actual y permite seleccionar otros proyectos. Otras opciones en el 
menú desplegable permiten crear un nuevo proyecto o abrir un proyecto existente.  
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• Reports and Publish (Informes y Publicar): En el administrador de proyectos, a 
la derecha de la lista del proyecto actual se encuentran los comandos de 
publicación e informes. Estos comandos son accesibles en todo el proyecto. El 
comando de informes proporciona acceso a herramientas que incluyen: Manejador 
de Datos, Importación/Exportación e Informes.  

 

 
 

• Project Panel (Panel del Proyecto): El panel del proyecto muestra una vista de 
árbol de los dibujos del proyecto. Los dibujos que se muestran en la pestaña de 
archivos de origen son dibujos P&ID y archivos de modelos 3D. Las pestañas 
DWG ortográfico y DWG isométrico contienen dibujos de salida generados a partir 
del modelo de tubería 3D. 
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• Details/Preview/History Panel (Panel de Detalles/Vista Previa/Historial): El 
panel inferior del administrador del proyecto proporciona información sobre el 
dibujo seleccionado en el panel del proyecto. Este panel alterna entre los detalles 
básicos del dibujo, la vista previa del dibujo y el historial del dibujo. 

 

 
 

Manejador de datos  
 
Cuando se agregan elementos a un P&ID o un modelo 3D, no solo se están agregando 
gráficos a un dibujo. Cada elemento agregado a un dibujo contiene propiedades además 
del símbolo gráfico. El Manejador de Datos proporciona una vista de la base de datos del 
proyecto.  
 

 
 
El software permite acceder al manejador de datos a través de cualquiera de las 
siguientes formas:  
 

1. Clic sobre el menú despegable de la herramienta Reports en el administrador de 
proyectos → Herramienta Data Manager.  
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2. Clic derecho sobre el nodo P&ID Drawings en el administrador de proyectos → 
Herramienta Data Manager. 

3. Clic derecho sobre el nodo Plant 3D Drawings en el administrador de proyectos → 
Herramienta Data Manager.  

 

 
 

4. Clic en la Pestaña Home → Panel Project → Herramienta Data Manager .  
 
El administrador de datos permite crear informes e importar/generar datos desde el 
proyecto. Además permite cambiar los datos en el dibujo ingresando los valores 
requeridos en el administrador de datos. La información del administrador de datos puede 
ser filtrada para una mejor visualización o presentación.  
 
Agregar tuberías o accesorios de tuberías usando Spec Viewer  
 
AutoCAD Plant 3D cuenta con una herramienta llamada “Spec Viewer”, la cual permite 
visualizar una hoja de especificaciones y colocar elementos de una determinada hoja de 
especificaciones en un modelo 3D de tubería. El visor de especificaciones (Spec Viewer) 
utiliza archivos de especificaciones para controlar el tamaño de la pieza, la selección y las 
prioridades de enrutamiento.  
 
El software permite acceder al Spec Viewer a través de cualquiera de las siguientes 
formas:  
 

1. Clic en la Pestaña Home → Panel Part Insertion → Herramienta Spec Viewer .  
2. Ingresar el comando PLANTSPECVIEWER en la línea de comandos.  
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Los pasos para agregar tuberías o accesorios de tubería en un modelo 3D a través del 
Spec Viewer son los siguientes:  
 

1. Para comenzar, activar el espacio de trabajo 3D Piping → Acceder a la 
herramienta Spec Viewer.  

2. En el cuadro de diálogo Spec Viewer, seleccionar el tipo de tubería deseada, a 
través del menú desplegable Spec:  

 

 
 

3. En la sección Spec Sheet, seleccionar el componente que se desea agregar al 
modelo.  
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4. Para finalizar, clic Insert in Model. En automático, el componente aparecerá 
cargado en la paleta de herramientas correspondiente.   

 

 
 

Caja de diálogo para asignación de tags  
 
AutoCAD Plant 3D permite asignar etiquetas a los componentes del dibujo P&ID o el 
modelo 3D a través de una herramienta llamada “Assign Tag”.   
 
Una etiqueta es un identificador único para un objeto dentro de AutoCAD Plant 3D. Es 
importante considerar que en un modelo 3D, la tubería, los accesorios de tubería, los 
soportes de tubería y los equipos tienen una etiqueta de forma predeterminada. Además, 
la tubería y los accesorios de tubería tienen una etiqueta adicional a la etiqueta que 
pueden tener todos los objetos, la cual indica el número de línea.  
 
El software permite acceder a Assign Tag a través de cualquiera de las siguientes formas:  
 

• Espacio de trabajo: 3D Piping 
 

1. Clic en la Pestaña Home → Panel Part Insertion → Herramienta Assing Tag . 
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• Espacio de trabajo: 3D Piping 
 

2. Clic en la Pestaña Home → Panel P&ID → Herramienta Assing Tag . 
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Capítulo 2 
 

Manejo de proyecto  
 
Configuración del ambiente de trabajo, dibujos y modelos  
 
AutoCAD Plant 3D permite configurar el proyecto y las preferencias de dibujo, así como la 
simbología de los componentes, las reglas de etiquetado, las propiedades de las 
anotaciones, las capas y los colores a través del cuadro de diálogo Project Setup.  
 
El cuadro de diálogo Project Setup (Configuración del Proyecto) muestra una estructura 
de árbol en el lado izquierdo que está poblada por elementos llamados nodos de árbol. 
Cuando se selecciona un nodo de árbol, el contenido específico del nodo se muestra en el 
lado derecho, donde se pueden realizar cambios o adiciones a la configuración del 
proyecto. 
 
El software permite acceder al cuadro de diálogo Project Setup a través de cualquiera de 
las siguientes formas:  
 

1. En el administrador de proyectos, clic derecho sobre el nombre del proyecto → Clic 
Project Setup.  

 

 
 

2. Clic en la Pestaña Home → Panel Project → Menú Desplegable Project Manager 

→ Herramienta Project Setup . 
3. Ingresar el comando PROJECTSETUP en la línea de comandos.  
 

Creación de proyectos  
 
AutoCAD Plant 3D utiliza un entorno de proyecto que facilita la creación y gestión de 
dibujos, modelos y otros archivos relacionados. La organización del proyecto también 
ayuda a garantizar que se esté trabajando con los datos y las plantillas correctos. 
 
Se debe crear un nuevo proyecto siempre que se necesite crear un diseño 
completamente nuevo y se requiera que los archivos de diseño estén separados de los 
diseños anteriores. El nuevo proyecto define el nuevo entorno del proyecto. 
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Los pasos para crear un nuevo proyecto son los siguientes: 
 

1. Para comenzar, en el administrador de proyectos, clic para desplegar el menú 
Current Project → Clic New Project.  

 

 
 

2. En el cuadro de diálogo Project Setup Wizard, ingresar los siguientes datos: 
Nombre del proyecto y Ruta para almacenar los archivos generados por el 
programa → Clic Next.  

 

 
 

3. Especificar las unidades base del proyecto → Clic Next.  
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4. Verificar la ruta de almacenamiento → Especificar la norma o estándar del 
proyecto → Clic Next.  

 

 
 

5. Verificar las rutas de almacenamiento → Clic Next.  
 

 
 

6. Definir el número de usuarios en el proyecto → Clic Next. 
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7. Para finalizar, clic Finish. En automático, el administrador de proyectos mostrará el 
diagrama de árbol correspondiente al proyecto creado.  

 

                    
 
Configuración de archivos DWG de AutoCAD P&ID  
 
AutoCAD Plant 3D permite configurar el estilo DWG de un dibujo P&ID y personalizarlo 
para satisfacer las necesidades específicas de un proyecto, de tal forma que se puedan 
controlar el tipo de datos que se desea incluir: atributos, estilos, formato, etc.  
 
Los pasos para configurar el estilo DWG de un dibujo P&ID son los siguientes: 
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  
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2. En el cuadro de diálogo Project Setup, desplegar la opción P&ID DWG Settings → 
Clic Line Settings → Configurar los datos deseados para el nuevo estilo P&ID.  

 

 
 

3. En el menú principal Project Setup, clic P&ID Painter Settings → Configurar los 
datos deseados para el nuevo estilo P&ID.  
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4. En el menú principal Project Setup, clic Pipe Specs in P&ID → Configurar los datos 
deseados para el nuevo estilo P&ID.  

 

 
   

5. Para finalizar y confirmar la configuración del nuevo estilo P&ID, clic OK.  
 
Configuración de archivos DWG de Plant 3D 
 
AutoCAD Plant 3D permite configurar el estilo DWG de un modelo 3D y personalizarlo 
para satisfacer las necesidades específicas de un proyecto, de tal forma que se puedan 
controlar el tipo de datos que se desea incluir: atributos, estilos, formato, etc.  
 
Los pasos para configurar el estilo DWG de un modelo 3D son los siguientes: 
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  
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2. En el cuadro de diálogo Project Setup, desplegar la opción Plant 3D DWG Settings 
→ Clic Layer and Color Settings → Configurar los datos deseados para el nuevo 
estilo Plant 3D.  

 

 
 

3. En el menú principal Project Setup, clic Piping Connection Settings → Configurar 
los datos deseados para el nuevo estilo Plant 3D.  
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4. En el menú principal Project Setup, clic Pipe Bend Settings → Configurar los datos 
deseados para el nuevo estilo Plant 3D.  

 

 
 

5. Para finalizar y confirmar la configuración del nuevo estilo Plant 3D, clic OK.  
 
Configuración de dibujos isométricos  
 
AutoCAD Plant 3D se instala con varios estilos Iso y tamaños de papel de forma 
predeterminada. AutoCAD Plant 3D permite agregar estilos Iso personalizados al proyecto 
para satisfacer las necesidades específicas de un proyecto. Cuando se crea un dibujo Iso, 
se puede usar el estilo Iso personalizado para controlar el tipo de datos que se desea 
incluir: atributos, estilos, formato, etc. 
 
Los pasos para crear y configurar un nuevo estilo Iso son los siguientes: 
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  
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2. En el cuadro de diálogo Project Setup, desplegar la opción Isometric DWG Settings 
→ Clic Iso Style Setup.  

 

 
 

3. En el cuadro de diálogo Iso Style Setup, clic Create a new Iso style . 
4. En el cuadro de diálogo Create Iso Style, ingresar los siguientes datos: Nombre del 

nuevo estilo → Seleccionar el estilo que se desea definir como base para el nuevo 
estilo → Clic Create.  

 

 
 

5. En el cuadro de diálogo Create Iso Style Setup, configurar los datos deseados para 
el nuevo estilo Iso.   
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6. En el menú principal Project Setup, clic Iso Style Default Settings → Configurar los 
datos deseados para el nuevo estilo Iso.   

 

 
 

7. En el menú principal Project Setup, clic Annotations → Configurar los datos 
deseados para el nuevo estilo Iso.   

 

 
 

8. En el menú principal Project Setup, clic Dimensions → Configurar los datos 
deseados para el nuevo estilo Iso.   
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9. En el menú principal Project Setup, clic Themes → Configurar los datos deseados 
para el nuevo estilo Iso.   

 

 
 

10. En el menú principal Project Setup, clic Soped and Offset Piping → Configurar los 
datos deseados para el nuevo estilo Iso.   

 

 
 

11. En el menú principal Project Setup, clic Title Block and Display → Configurar los 
datos deseados para el nuevo estilo Iso.   

 

 
 

12. Para finalizar y confirmar la configuración del nuevo estilo Iso, clic OK.  
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Organización de proyecto y archivos del proyecto  
 
Un proyecto en AutoCAD Plant 3D se compone de una colección de dibujos y otras 
formas de datos. Este enfoque mantiene la integridad de las relaciones entre los 
componentes del proyecto.  
 
Algunos de los dibujos que se utilizan como componentes de un proyecto en AutoCAD 
Plant 3D son: 
 

• Dibujos P&ID 

• Modelos 3D 

• Dibujos Ortográficos 

• Dibujos Isométricos  
 
Los datos adicionales que podrían usarse como parte de un proyecto típico son: 
 

• Información de proceso (por ejemplo: tablas de flujo) 

• Hojas de corte de equipos e instrumentos 

• Catálogo y especificaciones para tuberías 

• Análisis estructural 
 
Los datos que se utilizan en un proyecto se organizan en un sistema de carpetas 
predeterminadas. En la siguiente imagen se muestra un ejemplo de estructura de 
carpetas de proyectos: 
 

 
 

Hay varias formas de organizar los archivos de un proyecto. Los archivos se almacenan 
con mayor frecuencia en la carpeta de dibujos de P&ID o de dibujos de Plant 3D, o 
subcarpetas, con la estructura de carpetas equivalente creada en el directorio de 
proyectos de Windows. Se puede crear una carpeta separada para plantillas para 
almacenar los estándares de la empresa o del proyecto. 
 
Historial de seguimiento de cambios en el proyecto  
 
El historial de trabajo proporciona un historial de seguimiento de los cambios realizados 
en el dibujo. Esto permite realizar un seguimiento del estado y las notas agregadas a un 
dibujo. 
 
AutoCAD Plant 3D permite configurar un proyecto para solicitar el historial de trabajo al 
momento de abrir el proyecto, al momento de cerrarlo o nunca solicitarlo. 
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Los pasos para configurar el historial de seguimiento en un proyecto son los siguientes:  
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  

 

 
 

2. En el cuadro de diálogo Project Setup, desplegar la opción General Settings → Clic 
Project Details.  

 

 
 

3. En el cuadro de diálogo Project Details, en la sección Work history prompts, 
configurar la opción deseada para solicitar el historial de trabajo.  

 

 
 

4. Para finalizar y confirmar la configuración para solicitar el historial de trabajo, clic 
OK.  
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Compartir archivos de proyecto  
 
AutoCAD Plant 3D establece la ubicación para almacenar los cambios y el contenido del 
catálogo en la computadora. Los catálogos estándar se instalan en la carpeta de 
contenido compartido (Shared Content Folder). La ubicación predeterminada es: 
C:\AutoCAD Plant 3D 2021 Content\.  
 
Los archivos de especificaciones se instalan en la carpeta de contenido compartido y en 
la carpeta del proyecto predeterminada. Si se crea un proyecto, los archivos de 
especificaciones se copian desde la carpeta de contenido compartido al nuevo proyecto. 
 
De forma predeterminada, los archivos de especificaciones son específicos del proyecto, 
incluidos los archivos propios de especificaciones. Si se desea compartir archivos de 
especificaciones entre proyectos, se puede cambiar la carpeta del archivo de 
especificaciones mediante la configuración del proyecto.  
 
Los archivos de catálogo no forman parte de un proyecto.  
 
AutoCAD Plant 3D permite configurar el conjunto de herramientas para que compruebe 
periódicamente si hay cambios en un archivo de especificaciones. Cuando se agrega una 
pieza a un modelo de tubería, el modelo conserva toda la información, incluso si se 
elimina la pieza del archivo de especificaciones. 
 
Los pasos para configurar la ubicación de la carpeta de contenido compartido de un 
proyecto son los siguientes:  
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  
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2. En el cuadro de diálogo Project Setup, desplegar la opción General Settings → Clic 
Shared Plant Content.  

 

 
 

3. En el cuadro de diálogo Shared Plant Content, configurar o corroborar la ubicación 
de la carpeta de contenido compartido.  

4. Para finalizar y confirmar la ubicación de la carpeta, clic OK.  
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Capítulo 3 
 

Crear y modificar archivos P&ID 
 
Entendiendo componentes y líneas P&ID 
 
Los componentes necesarios para crear un diseño P&ID se encuentran en las diferentes 
pestañas de la paleta de herramientas correspondiente, la cual está dividida de la 
siguiente forma:  
 

• Lines Tab: Contiene las herramientas para agregar tuberías y líneas de 
instrumentación al dibujo. 

 

 
 

• Equipment Tab: Contiene las herramientas para agregar bombas, compresores, 
tanques, entre otros equipos al dibujo.  
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• Valves Tab: Contiene las herramientas para agregar válvulas a líneas de tubería 
del dibujo.   

 

 
 

• Fittings Tab: Contiene las herramientas para agregar boquillas y conexiones a 
líneas de tubería del dibujo.   
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• Instruments Tab: Contiene las herramientas para agregar instrumentación a 
líneas de tubería o instrumentación del dibujo.   
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• Non-engineering Tab: Contiene las herramientas para agregar diversos 
elementos que complementen al dibujo.   

 

 
 
Agregar componentes P&ID 
 
Equipos 
 
Los pasos para colocar un equipo en un dibujo P&ID son los siguientes: 
 

1. Para comenzar, activar el espacio de trabajo PID con la norma deseada → Activar 
el espacio de trabajo Model en la barra de estado.  

2. En la paleta de herramientas P&ID, clic en la Pestaña Equipment → Clic sobre el 
equipo deseado.  
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3. En el área de dibujo, clic en el punto donde se colocará el equipo → Mover el 
cursor para escalar y modificar las dimensiones del equipo.  

4. Para finalizar, clic para fijar la posición del componente.  
 

 
 

Válvulas, Conexiones e Instrumentos  
 

Los pasos para colocar una conexión en un dibujo P&ID son los siguientes: 
 

1. Para comenzar, activar el espacio de trabajo PID con la norma deseada → Activar 
el espacio de trabajo Model en la barra de estado.  

2. En la paleta de herramientas P&ID, clic en la Pestaña Valves/Fittings/Instruments 
→ Clic sobre el elemento deseado.   

 

 
 

3. En el área de dibujo, clic en el punto donde se colocará el elemento → Mover el 
cursor para definir la dirección o sentido del elemento.  

4. Para finalizar, clic para fijar la posición del componente.  
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Líneas esquemáticas  
 
Líneas de tubería  
 
Los pasos para colocar la representación de una tubería en un dibujo P&ID son los 
siguientes: 
 

1. Para comenzar, activar el espacio de trabajo PID con la norma deseada → Activar 
el espacio de trabajo Model en la barra de estado.  

2. En la paleta de herramientas P&ID, clic en la Pestaña Lines → Clic sobre la línea 
de tubería deseada.  

 

 
 

3. En el área de dibujo, clic en el punto donde iniciará el segmento de tubería → 
Mover el cursor para definir la trayectoria de la tubería → Clic para fijar el punto 
donde finalizará el segmento de tubería. Repetir este paso las veces que sean 
requeridas.  

 

 
 

4. Para finalizar, presionar la tecla ESC.   
 
Líneas de instrumentación  
 
Los pasos para colocar la representación de una línea de instrumentación en un dibujo 
P&ID son los siguientes: 
 

1. Para comenzar, activar el espacio de trabajo PID con la norma deseada → Activar 
el espacio de trabajo Model en la barra de estado.  
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2. En la paleta de herramientas P&ID, clic en la Pestaña Lines → Clic sobre la línea 
de instrumentación deseada.  

 

 
 

3. En el área de dibujo, clic en el punto donde iniciará el segmento de línea → Mover 
el cursor para definir la trayectoria de la línea → Clic para fijar el punto donde 
finalizará el segmento de línea. Repetir este paso las veces que sean requeridas.  

 

   
 

4. Para finalizar, presionar la tecla ESC.         
 
Tags y anotaciones en líneas y componentes  
 
Los tags o etiquetas de datos son información asignada a un símbolo P&ID para transmitir 
información vital sobre un componente. Una etiqueta es un identificador único que se 
utiliza para etiquetar cada componente de un proyecto de forma individual. Los datos se 
pueden mostrar en el dibujo si es necesario, pero siempre se mantienen en el manejador 
de datos. 
 
Una anotación es la información de texto colocada en el dibujo. Las anotaciones incluyen 
el valor de la etiqueta y, a menudo, incluyen otras propiedades sobre un componente. 
Según el tipo de símbolo seleccionado, los estilos de anotación disponibles varían. 
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Los pasos para asignar información y colocar una anotación sobre un objeto P&ID son los 
siguientes: 
 

1. Para comenzar, seleccionar el objeto → Clic derecho → Herramienta Assign Tag.  
 

 
 

2. En el cuadro de diálogo Assign Tag, asignar la información correspondiente al 
elemento → Activar la opción Place annotation after assigning tag → Seleccionar 
el estilo de anotación deseado en Annotation style → Clic Assign.  

 

 
 

3. Para finalizar, seleccionar el punto de inserción de la anotación → Clic sobre el 
punto de inserción. En automático, el elemento de anotación se verá reflejado.  
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Una vez que el elemento de anotación ha sido colocado, este puede ser editado de la 
siguiente forma: 
 

1. Para comenzar, seleccionar el elemento de anotación → Clic derecho → 
Herramienta Edit.  

 

 
 

2. En el cuadro de diálogo Edit Annotation, realizar las modificaciones deseadas en la 
información correspondiente al elemento.  

3. Para finalizar y confirmar los cambios, clic OK.  
 

 
 
Convertir objetos de AutoCAD a componentes o líneas P&ID  
 
AutoCAD P&ID permite crear dibujos P&ID que coincidan con los requisitos de una 
industria o empresa. Si existe la necesidad de emplear un símbolo que AutoCAD P&ID 
aún no tiene, se puede crear un símbolo personalizado. 
 
Los pasos para crear un símbolo P&ID personalizado son los siguientes: 
 

1. Para comenzar, utilizando las herramientas estándar de AutoCAD, crear una 
geometría que represente el símbolo requerido.  

 

 
 

2. Seleccionar la geometría → Clic derecho → Herramienta Convert to P&ID Object.  
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3. En el cuadro de diálogo Convert to P&ID Object, asignar el Class correspondiente 
al tipo de símbolo creado → Click OK.  

 

 
 

4. Para finalizar, seleccionar el punto de inserción del símbolo → Clic sobre el punto 
de inserción. En automático, el color del símbolo se actualizará para reflejar el 
Class asignado.  

 

       
 

Una vez que el símbolo ha sido convertido, este puede ser editado de la siguiente forma: 
 

1. Para comenzar, seleccionar el bloque → Clic derecho → Herramienta Edit P&ID 
Object’s Block.  

 

 
 

2. Editar el bloque utilizando las herramientas estándar de AutoCAD.  
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3. Para finalizar y confirmar los cambios, clic .  
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Capítulo 4 
 

Importación de dibujos P&ID a modelos 3D 
 
Ruteo de tuberías basado en líneas P&ID 
 
Debido a que los diseños de las plantas comienzan con la creación de un dibujo P&ID y 
toda la información se captura en ese dibujo, solo tiene sentido reutilizar directamente lo 
que existe durante la creación del modelo 3D. 
 
Si bien los modelos 3D pueden tener la misma información que el dibujo P&ID, la 
información no está vinculada entre los dibujos. Esto significa que, si se produce un 
cambio de diseño, cambiar la información en una ubicación no actualiza automáticamente 
la otra ubicación. Para asegurar que todo esté sincronizado entre los dibujos, se debe 
ejecutar una validación. 
 
Para obtener visibilidad sobre los componentes de especificaciones disponibles al dibujar 
líneas en un P&ID, se debe habilitar la opción P&ID basada en especificaciones a través 
de los siguientes pasos: 
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  
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2. En el cuadro de diálogo Project Setup, desplegar la opción P&ID DWG Settings → 
Clic Pipe Specs in P&ID.  

 

 
 

3. En el cuadro de diálogo Pipe Specs in P&ID, activar la opción Spec Driven Project.  
 

 
 

4. Para finalizar y confirmar los cambios, clic OK.  
 

Una vez que un proyecto P&ID se convierte en un proyecto impulsado por 
especificaciones, se debe preseleccionar la especificación de la tubería de la lista 
desplegable antes de dibujar los componentes de la especificación. Esta lista contiene la 
lista de tamaños de tubería disponibles. Si un tamaño muestra un patrón de sombreado 
rayado, significa que el tamaño no está disponible en la especificación de tubería 3D 
seleccionada.  
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Colocación de válvulas, accesorios y equipamiento  
 
Para agregar válvulas, accesorios o equipos en una línea de tubería que ya ha sido 
creado en un dibujo P&ID:  
 

1. Para comenzar, clic en la Pestaña Home → Panel Part Insertion → Herramienta 

P&ID Line List .  
2. En la paleta P&ID Line List, seleccionar el dibujo P&ID que se desea utilizar.  

 

 
 

3. Seleccionar el número de línea o el equipo en línea que se desea agregar → Clic 
Place. 

 

 
 

4. Para finalizar, colocar el elemento en el lugar deseado dentro del modelo 3D.  
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Modificación de tamaños  
 
Para modificar la especificación de tamaño de un componente o tubería: 
 

1. Para comenzar, seleccione la tubería o elemento que se desea modificar de 
tamaño → Clic derecho sobre el elemento → Herramienta Properties.  

 

 
 

2. En la paleta de propiedades, ubicar la sección Plant 3D → Desplegar el menú de la 
propiedad Size → Seleccionar la dimensión deseada.  

 

 
 

3. Para finalizar, verificar los cambios en el elemento.  
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Capítulo 5 
 

Validación de proyectos  
 
Validar y corregir archivos P&ID 
 
Para ejecutar la validación en un dibujo P&ID:  
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el dibujo que 
se desea validar → Clic Validate.  

 

 
 

2. En la paleta Validation Summary, desplegar el listado de errores en el dibujo → 
Seleccionar el error que se desea visualizar en el dibujo.  

 

 
 

3. Realizar las correcciones requeridas en el dibujo. Repetir la operación las veces 
que se requiera para atender los errores encontrados.  

4. Para finalizar, clic en la Herramienta Revalidate Selected Node  en la paleta 
Validation Summary.  
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Validar y corregir modelos 3D 
 
Cuando se crean modelos Plant 3D basados en dibujos P&ID, la información utilizada y 
agregada al modelo no está vinculada al dibujo P&ID. Para garantizar que el diseño y los 
datos entre el dibujo P&ID y el modelo Plant 3D estén sincronizados, se debe validar el 
proyecto. Después de ejecutar la validación, cualquier problema que exista entre los 
dibujos será enumerado en la paleta Validation Summary.  
 
Para ejecutar la validación en un modelo 3D: 
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el dibujo que 
se desea validar → Clic Validate.  

 

 
 

2. En la paleta Validation Summary, desplegar el listado de errores entre los dibujos 
→ Seleccionar el error que se desea visualizar en el modelo.  

 

 
 

3. Realizar las correcciones requeridas en el modelo. Repetir la operación las veces 
que se requiera para atender los errores encontrados.  

4. Para finalizar, clic en la Herramienta Revalidate Selected Node  en la paleta 
Validation Summary.  
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Capítulo 6 
 

Trabajo con modelos 3D 
 
Crear y modificar equipos  
 
El panel Equipment, en la pestaña Home, incluye herramientas para crear, modificar y 
adjuntar equipos en un modelo 3D.  
 
Para crear un equipo en un modelo 3D: 
 

1. Para comenzar, activar el espacio de trabajo 3D Piping.  

2. Clic en la Pestaña Home → Panel Equipment → Herramienta Create .  
3. En el cuadro de diálogo Create Equipment, especificar el tipo de equipo y las 

propiedades deseadas para el mismo → Clic Create.  
 

 
 

4. Para finalizar, colocar el equipo en la ubicación deseada dentro del modelo 3D.  
 
Para modificar un equipo en un modelo 3D: 
 

1. Para comenzar, seleccionar el equipo que se desea modificar → Clic derecho → 
Herramienta Modify Equipment.  
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2. En el cuadro de diálogo Modify Equipment, especificar los nuevos valores 
deseados.  

 

 
 

3. Para finalizar, clic OK.  
 
Crear y modificar estructuras  
 
La pestaña Structure contiene las herramientas y comandos relacionados con la 
generación de piezas estructurales en el espacio de modelado 3D. Está disponible 
cuando el espacio de trabajo 3D Piping está activo. 
 

 
 
Para crear un componente estructural en un modelo 3D: 
 

1. Para comenzar, activar el espacio de trabajo 3D Piping.  

2. En la barra de estado, clic Grid Display .  

3. Clic en la Pestaña Structure → Panel Parts → Herramienta Grid .  
4. En el cuadro de diálogo Create Grid, especificar el sistema de coordenadas y los 

valores deseados para generar el elemento → Clic Create.  
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5. Clic en la Pestaña Structure → Panel Parts → Menú Desplegable Settings → 

Herramienta Member Settings .  
6. En el cuadro de diálogo Member Settings, especificar las características del 

componente estructural deseado → Clic OK.  
 

 
 

7. Clic en la Pestaña Structure → Panel Parts → Herramienta Member  → 
Especificar el punto de inicio del componente estructural → Especificar el punto 
final del componente estructural → Presionar ENTER para finalizar el comando.  

8. Para finalizar, repetir los pasos 6 y 7 las veces que sea requerido hasta completar 
la estructura deseada.  

 

 
 

Para modificar un componente estructural en un modelo 3D: 
 

1. Para comenzar, seleccionar el elemento que se desea modificar → Clic derecho → 
Herramienta Edit Structure.  
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2. En el cuadro de diálogo Edit Member, especificar los nuevos valores deseados. 
 

 
 

3. Para finalizar, clic OK.  
 
Crear y modificar tuberías  
 

La herramienta Route Pipe  permite dibujar una tubería en el modelo. Para conectar 
una tubería a una boquilla en un equipo existente, se debe utilizar la referencia Node 
Object Snap cuando se el software solicite un punto de inicio para la tubería.  
 
Para crear una tubería en un modelo 3D: 
 

1. Para comenzar, activar el espacio de trabajo 3D Piping.  
2. Clic en la Pestaña Home → Panel Part Insertion → Asignar el tipo de tubería y la 

dimensión deseada para la misma.  
 

 
 

3. Clic en la Pestaña Home → Panel Part Insertion → Herramienta Route Pipe . 
4. Especificar el punto de inicio de la tubería → Girar el mouse para especificar la 

dirección de la tubería → Especificar el punto final de la tubería.  
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5. Para cambiar el sentido de la tubería de horizontal a vertical, presionar 
CTRL+CLIC DERECHO.  

 

 
 

6. Repetir los pasos 4 y 5 las veces que sea requerido hasta completar la trayectoria 
deseada.  

7. Para finalizar, presionar ENTER para finalizar el comando.  
 
Para modificar la elevación de una tubería en un modelo 3D: 
 

1. Para comenzar, seleccionar la tubería que se desea modificar → Seleccionar el 

grip    → Ingresar los nuevos valores de elevación deseados de para la tubería.  
 

 
 

2. Para confirmar los cambios, presionar ENTER.  
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Para agregar bifurcaciones en una tubería en un modelo 3D: 
 

1. Para comenzar, seleccionar la tubería donde se desea agregar la bifurcación → 

Seleccionar el grip  → Trazar la trayectoria de la bifurcación.  
 

 
 

2. Para finalizar, presionar ENTER para finalizar el comando.  
 
Estilos de visualización y control de visibilidad de objetos Plant 3D 
 
AutoCAD Plant 3D permite configurar la visibilidad de todos los objetos de Plant 3D, 
incluidas las tuberías, los equipos y la estructura. 
 
Para cambiar el estilo de visualización del modelo 3D: 
 

1. Para comenzar, clic en la Pestaña Home → Panel View → Menú View Styles.  
2. Seleccionar el estilo de visualización deseado.  

 

 
 

3. Para finalizar, confirmar que el estilo visual haya sido aplicado al modelo.  
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Para ocultar/mostrar objetos en un modelo 3D: 
 

1. Para comenzar, clic en la Pestaña Home → Panel Visibility → Herramienta Hide 

Selected .  
2. Seleccionar los objetos que se desean ocultar.  

 

 
 

3. Para confirmar, presionar ENTER.  
 

 
 

4. Para mostrar los elementos ocultos, clic en la Pestaña Home → Panel Visibility → 

Herramienta Show All .  
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Capítulo 7 
 

Trabajo con isométricos  
 
Configuración de estilos y temas para isométricos  
 
AutoCAD Plant 3D se instala con varios estilos Iso y tamaños de papel de forma 
predeterminada. AutoCAD Plant 3D permite agregar estilos Iso personalizados al proyecto 
para satisfacer las necesidades específicas de un proyecto. Cuando se crea un dibujo Iso, 
se puede usar el estilo Iso personalizado para controlar el tipo de datos que se desea 
incluir: atributos, estilos, formato, etc. 
 
Los pasos para crear y configurar un nuevo estilo Iso son los siguientes: 
 

1. Para comenzar, en el administrador de proyectos, clic derecho sobre el nombre del 
proyecto → Clic Project Setup.  

 

 
 

2. En el cuadro de diálogo Project Setup, desplegar la opción Isometric DWG Settings 
→ Clic Iso Style Setup.  

 

 
 

3. En el cuadro de diálogo Iso Style Setup, clic Create a new Iso style . 
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4. En el cuadro de diálogo Create Iso Style, ingresar los siguientes datos: Nombre del 
nuevo estilo → Seleccionar el estilo que se desea definir como base para el nuevo 
estilo → Clic Create.  

 

 
 

5. En el cuadro de diálogo Create Iso Style Setup, configurar los datos deseados para 
el nuevo estilo Iso.   

 

 
 

6. En el menú principal Project Setup, clic Iso Style Default Settings → Configurar los 
datos deseados para el nuevo estilo Iso.   
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7. En el menú principal Project Setup, clic Annotations → Configurar los datos 
deseados para el nuevo estilo Iso.   

 

 
 

8. En el menú principal Project Setup, clic Dimensions → Configurar los datos 
deseados para el nuevo estilo Iso.   

 

 
 

9. En el menú principal Project Setup, clic Themes → Configurar los datos deseados 
para el nuevo estilo Iso.   
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10. En el menú principal Project Setup, clic Soped and Offset Piping → Configurar los 
datos deseados para el nuevo estilo Iso.   

 

 
 

11. En el menú principal Project Setup, clic Title Block and Display → Configurar los 
datos deseados para el nuevo estilo Iso.   

 

 
 

12. Para finalizar y confirmar la configuración del nuevo estilo Iso, clic OK.  
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Generación de isométricos básicos  
 
Para generar un dibujo isométrico básico:  
 

1. Para comenzar, clic en la Pestaña Isos → Panel Iso Creation → Herramienta Quick 

Iso .  
2. Seleccionar los componentes que se desean incluir en el dibujo → Presionar 

ENTER.  
 

 
 

3.  En el cuadro de diálogo Create Quick Iso, seleccionar el estilo Iso que se desea 
aplicar al dibujo → Clic Create.  

 

 
 

4. Para finalizar, visualizar los resultados de la creación.  
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Generación de isométricos para producción  
 
Para generar un dibujo isométrico para producción:  
 

1. Para comenzar, Clic en la Pestaña Isos → Panel Iso Creation → Herramienta 

Production Iso .  
2. En el cuadro de diálogo Create Production Iso → Seleccionar el número de línea 

de tubería sobre la cual se desea producir el isométrico → Seleccionar el estilo Iso 
que se desea aplicar al dibujo → Clic Create.  

 

 
 

3. Para finalizar, visualizar los resultados de la creación.  
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Capítulo 8 
 

Dibujos ortográficos  
 
Creación de modelos ortográficos  
 
Para generar un dibujo ortográfico: 
 

1. Para comenzar, Clic en la Pestaña Home → Ortho View → Herramienta Create 

Ortho View . 
2. En el cuadro de diálogo Select Orthographic Drawing, clic Create New.  
3. En el cuadro de diálogo New DWG, ingresar el nombre deseado para el nuevo 

archivo → Clic OK.  
 

 
 

4. Para finalizar, verificar que se active la pestaña Ortho Editor.  
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Vistas ortográficas  
 
Para generar una vista ortográfica: 
 

1. Para comenzar, generar un dibujo ortográfico. 
2. Clic en la Pestaña Ortho Editor → Panel Ortho Cube → Menú Desplegable Front 

→ Seleccionar la perspectiva deseada para la vista.  
 

 
 

3. En el modelo 3D, ajustar el bloque de selección al área que se desea documentar.  
 

 
 

4. Clic en la Pestaña Ortho Editor → Panel Library → Herramienta Save Ortho Cube 

.  
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5. En el cuadro de diálogo Save View, ingresar el nombre deseado para la vista → 
Clic OK.  

 

  
 

6. En la Pestaña Ortho Editor → Panel Output Size → Especificar el tamaño de papel 
deseado.  

 

 

7. Clic en la Pestaña Ortho Editor → Panel Create → Herramienta OK .  
8. Para finalizar, especificar el punto donde se desea colocar el dibujo.  
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Acotación y anotación de modelos ortográficos  
 
Para acotar un elemento de anotación en una vista ortográfica:  
 

1. Para comenzar, activar la vista que se desea documentar.  
2. Clic en la Pestaña Ortho View → Panel  

Dimensions → Menú Desplegable Dimension → Seleccionar el tipo de cota 
deseado.  

 

 
 

3. Seleccionar el punto inicial de la cota → Seleccionar el punto final de la cota.  
 

 
 

4. Para finalizar, clic sobre la cota para fijarla.  
 
Para colocar un elemento de anotación en una vista ortográfica: 
 

1. Para comenzar, activar la vista que se desea documentar.  
2. Clic en la Pestaña Ortho View → Panel Table Placement & Setup → Herramienta 

Bill of Materials .  
 
 
 
 
 
 
 
 



74 
 

3. En el dibujo, seleccionar el viewport que se desea documentar.  
 

 
 

4. En el dibujo, especificar el punto inicial de la tabla de materiales → Especificar el 
punto final de la tabla de materiales.  

5. Clic en la Pestaña Ortho View → Panel Annotation → Herramienta BOM 

Annotation .  
6. En el listado de materiales, seleccionar el componente que se desea acotar. En 

automático, el software referenciará el componente en la vista ortográfica.  
 

 
 

7. En la vista, clic para ubicar el elemento de anotación.  
 

 
 

8. Para finalizar, presionar ESC. 
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Capítulo 9 
 

Generación de reportes  
 
Trabajo con el Data Manager  
 
Cuando se agregan elementos a un P&ID o un modelo 3D, no solo se están agregando 
gráficos a un dibujo. Cada elemento agregado a un dibujo contiene propiedades además 
del símbolo gráfico. El Manejador de Datos proporciona una vista de la base de datos del 
proyecto.  
 

 
 
El manejador de datos tiene cuatro áreas principales:  
 

• Lista Desplegable: Permite seleccionar entre los datos actuales del dibujo, los 
datos del proyecto o los informes del proyecto.  
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• Lista de Clases (Class List): Permite restringir los datos que se muestran según 
los componentes comunes de P&ID.  

 

 
 

• Barra de Herramientas: Permite realizar tareas, como importar y exportar datos, 
ocultar columnas en blanco e imprimir.  

 

 
 

• Datos: Los datos del dibujo o proyecto se ubican en una configuración de columna 
y fila similar a una hoja de cálculo típica. 
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Los pasos para visualizar información en el manejador de datos son los siguientes:  
 

1. Para comenzar, activar el manejador de datos.  
2. En el manejador de datos, en la lista desplegable, seleccionar los datos que se 

desean visualizar.  
 

 
 

3. Seleccionar la clase que se dese visualizar.  
 

 
 

4. Para finalizar, visualizar los datos.  
 

 
 
Reportes  
 
La lista desplegable del manejador de datos muestra los tipos de informe y los informes 
de un proyecto actual.  
 
Los tipos de informe predeterminados incluyen: 
 

• Lista de Válvulas de Control: Muestra un informe de los datos de las válvulas de 
control en el proyecto.  
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• Registro de Documentos: Muestra un informe de dibujos en el proyecto.  
 

 
 

• Lista de Equipos: Muestra un informe de los datos de los equipos en el proyecto.  
 

 
 

• Lista de Instrumentos: Muestra un informe de los datos de los instrumentos en el 
proyecto.  
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• Lista de Líneas: Muestra un informe de los datos de líneas de tubería en el 
proyecto.  
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• Lista de Resumen de Líneas: Muestra un informe resumido de los datos de 
líneas de tubería en el proyecto.  
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• Lista de Boquillas: Muestra un informe de los datos de las boquillas en el 
proyecto.  
 

 
 

• Lista de Artículos Especiales: Muestra un informe de los datos de los artículos 
especiales en el proyecto: trampas de vapor, filtros de cono, etc.  
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• Lista de Válvulas: Muestra un informe de los datos de las válvulas en el proyecto.  
 

 
 
Exportación e importación de datos  
 
Los datos solo son útiles si son precisos y llegan a las personas que los necesitan. Para 
compartir la información del manejador de datos con otras personas fuera del equipo de 
diseño, AutoCAD Plant 3D permite exportar los datos a una hoja de cálculo de Excel o a 
un archivo CSV. 
 
Para exportar los datos de un proyecto: 
 

1. Para comenzar, activar el manejador de datos.  
2. En el manejador de datos, seleccionar el tipo de reporte que se desea exportar.  
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3. En la barra de herramientas del manejador de datos, clic en la Herramienta Export 

.  
4. En el cuadro de diálogo Export To, especificar la ruta de ubicación, el nombre y 

formato de exportación del reporte → Clic Save.  
 

 
 

5. Para finalizar, verificar que el reporte se haya generado en la ruta previamente 
especificada → Visualizar el reporte.  

 

 
 

Hay muchas razones para importar datos a un proyecto P&ID. Los clientes pueden 
realizar cambios en el diseño, las especificaciones del equipo pueden cambiar o los datos 
podrían haberse exportado porque es más fácil agregar y editar datos en una hoja de 
cálculo. 
 
Al importar datos, es fundamental que el nombre de la hoja de trabajo y los encabezados 
de columna coincidan con los nombres de vista / clases y propiedades en el manejador de 
datos. Por lo tanto, es recomendable exportar los datos actuales a una hoja de cálculo y 
editar la hoja de cálculo exportada. 
 
Para importar los datos de un proyecto: 
 

1. Para comenzar, activar el manejador de datos.  
2. En la barra de herramientas del manejador de datos, clic en la Herramienta Import 

. 
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3. En el cuadro de diálogo emergente, clic OK para confirmar la operación.  
 

 
 

4. En el cuadro de diálogo Import From, seleccionar el archivo que se desea importar.  
 

 
 

5. Para finalizar, verificar la información en el manejador de datos.  
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